Release Notes
CaseMap®, Version 10.X

- Enhancements
- Resolved Issues
- Current Issues
Table of Contents

Chapter 1 CaseMap v10.X

1 Overview .................................................................................................................. 4

2 Enhancements .............................................................................................................. 5
   10.3 Build 376 ............................................................................................................ 5
   10.2 Build 265 ............................................................................................................ 5
   10.1 Build 67 ............................................................................................................. 6
   10.1 Build 63 ............................................................................................................. 6
   10.0 Build 233 .......................................................................................................... 7
   10.0 Build 227 .......................................................................................................... 7

3 Resolved Issues ...................................................................................................... 9
   10.2 Build 266 .......................................................................................................... 9
   10.2 Build 265 .......................................................................................................... 10
   10.1 Build 75 ............................................................................................................ 10
   10.1 Build 74 ............................................................................................................ 11
   10.1 Build 69 ............................................................................................................ 11
   10.1 Build 66 ............................................................................................................ 11
   10.1 Build 63 ............................................................................................................ 12
   10.0 Build 244 .......................................................................................................... 12
   10.0 Build 241 .......................................................................................................... 13
   10.0 Build 233 .......................................................................................................... 13
   10.0 Build 229 .......................................................................................................... 14
   10.0 Build 227 .......................................................................................................... 14

4 Current Issues ..................................................................................................... 15
   10.1 Build 67 .......................................................................................................... 15
   10.0 Build 227 .......................................................................................................... 15

Index ..................................................................................................................... 0

© 2014 LexisNexis. All rights reserved.
CaseMap v10.X

Overview

Version 10.X

The CaseMap Release Notes provide a list of new features, resolved issues, and current issues for the version 10.X release. The current issues may be addressed in an update or other future release of CaseMap.

Enhancements

10.3 Build 376 - October 21, 2014
10.2 Build 265 - May 2, 2014
10.1 Build 67 - December 4, 2012
10.1 Build 63 - June 18, 2012
10.0 Build 233 - February 24, 2012
10.0 Build 227 - February 13, 2012

Resolved Issues

10.2 Build 265 - May 2, 2014
10.1 Build 75 - August 9, 2013
10.1 Build 74 - June 14, 2013
10.1 Build 69 - March 28, 2013
10.1 Build 66 - July 13, 2012
10.1 Build 63 - June 18, 2012
10.0 Build 244 - May 2, 2012
10.0 Build 241 - April 4, 2012
10.0 Build 233 - February 24, 2012
10.0 Build 229 - February 16, 2012
10.0 Build 227 - February 13, 2012
Current Issues

10.1 Build 67 - December 4, 2012
10.0 Build 227 - February 13, 2012

Enhancements

10.3 Build 376

The following enhancements have been added to CaseMap version 10.3 (Build 376) released October 21, 2014:

- **OCR Image PDF with Bates Stamps**
  
  CaseMap now performs OCR processing on image-only (no text) PDFs with Bates stamps and other short header and footer text.

- **Needs OCR column added to Linked File Index Status**
  
  CaseMap now provides a new "Needs OCR" column on the Indexed tab of the Linked File Index Status dialog box that allows you to identify documents that need OCR processing.

- **Skipped PDF tab added to Linked File OCR Status**
  
  CaseMap now provides a new "Skipped PDF" tab on the Linked File OCR Status dialog box that displays PDF documents for which OCR processing has been skipped.

10.2 Build 265

The following enhancements have been added to CaseMap version 10.2 (Build 265) released May 2, 2014:

- **Send documents to Sanction 3.5 or later as exhibits**
  
  CaseMap now allows you to send documents to Sanction 3.5 or later as exhibits. You can send one document at a time or send all of the document in the current spreadsheet.
10.1 Build 67

The following enhancements have been added to CaseMap version 10.1 (Build 67) released December 4, 2012:

- **Use the Acrobat plug-in with Acrobat 11**
  
  CaseMap’s Adobe® Acrobat plug-in now supports Acrobat version 11. All of the existing features work as they did with prior versions of Acrobat.

10.1 Build 63

The following enhancements have been added to CaseMap version 10.1 (Build 63) released June 18, 2012:

- **Store case data using Microsoft SQL Server**
  
  Leverage the performance of a Microsoft® SQL Server® database while still taking advantage of all of the great new features in CaseMap version 10. Coupled with an updated version of the CaseMap Server, administrators can create and manage SQL cases, as well as assign permissions for many of the new features.

- **Viewing linked files in the native application instead of DocManager**
  
  DocManager can now be configured so that files can be viewed in their native applications rather than automatically displaying in the DocManager file viewer. To automatically view linked files in the native application, click Tools, then click Options and then clear the Open Linked Files in DocManager check box.

- **Use the Search Link Assistant to simplify searches for object and issue names**
  
  The Search Link Assistant makes it even easier to search case data by automatically searching for links to objects and issues with names that match the search criteria. Take advantage of the benefits of using short names for linking without complicating your searches.

  The Search Link Assistant is enabled by default, but you can turn it off from the Tools > Options > Searching tab if you want more precise control over what the search includes.
10.0 Build 233

The following enhancements have been added to CaseMap version 10.0 (Build 233) released February 24, 2012:

- **Improved performance when embedding linked files in a PDF report**

  CaseMap now only makes copies of linked files specifically selected to be included in the PDF report, rather than making copies of all files available to include.

10.0 Build 227

The following enhancements have been added to CaseMap version 10.0 (Build 227) released February 13, 2012:

- **View linked files in the DocManager near native viewer**

  CaseMap is integrated with the new DocManager near native image viewer. Use DocManager to review and annotate documents and images without having to open the source file in its native application. Annotations can also have searchable notes that edited later. Annotation notes display as search results findings when the notes match the search query.

  When a search is run in CaseMap, search hits will be highlighted in DocManager allowing for easier content review and navigation between search hits. Once content is reviewed and annotated, the annotations and notes are automatically saved. When printing annotated files, there is an option for including annotations and notes when printing to PDF.

- **Benefit from OCR processing of linked files**

  CaseMap automatically performs OCR (optical character recognition) processing on linked image files and PDFs so that the text content can be indexed for full-text searching. CaseMap runs the OCR process in the background while staff continue working in the case file. The OCR process also makes it possible to select, copy, and annotate text in DocManager when viewing these linked files.

- **Use the new Import Linked Files Wizard to bulk import files**

  Use the new Import Linked Files Wizard to import one or more files into a spreadsheet at one time. CaseMap automatically creates new records for each file while linking to the source file saved in a network folder.

  Use the wizard to import a folder of files, including files saved in subfolders. The Import Linked Files Wizard is the quickest and easiest method of populating a CaseMap case with multiple documents at one time.

- **Send facts from Microsoft Outlook emails**
Use CaseMap's Outlook plug-in to send emails from Microsoft® Outlook 2007 and 2010 to a CaseMap v10+ case. In Outlook 2007, the Send to CaseMap features display on a CaseMap menu as a toolbar button and as a CaseMap ribbon. In Outlook 2010, it displays as a CaseMap ribbon. The Outlook plug-in is optional during CaseMap installation.

Send facts and documents from Microsoft Word

Send fact text and documents directly from Microsoft® Word 2007 and 2010 (32-bit versions). The Send to CaseMap features display on a CaseMap ribbon within Word. The Word plug-in is optional during CaseMap installation.

Create custom spreadsheets

CaseMap now provides the ability to create custom sub-object spreadsheets. New custom spreadsheets contain five default fields: Full Name, Short Name, Role In Case, Key, and # Facts. Additional fields can be added to the new spreadsheet as needed.

When a new spreadsheet is added, it can be used just like any other CaseMap spreadsheet. Data can be sent to it immediately using the Send to CaseMap tool. All reporting options are also available on new spreadsheets.

Learn about more spreadsheet features

CaseMap offers more customization options for spreadsheets than ever before, including the ability to:

- Rename many sub-object spreadsheets to best suit organizational needs.
- Delete spreadsheets from the Case Shortcuts pane.
- Change the spreadsheet display order in the Case Shortcuts pane.

Batch print linked files

CaseMap's DocManager add-in program includes a Batch Print Wizard that allows for printing documents linked to object spreadsheets, research spreadsheets (Authorities and Extracts from Authorities spreadsheets), and the Facts spreadsheet. Linked documents can be printed to a printer, or PDF or TIFF file. The wizard provides an option for removing any documents from the selected batch prior to printing.

If documents are annotated, the Batch Print Wizard includes an option to print to PDF with or without annotations and notes or burn the annotation as a permanent part of the content (without notes). The annotation color for printing annotations can be also be modified.

The Batch Print Wizard also provides the ability to apply Bates stamps to documents included in the printed output. Various Bates stamp settings allow for customizing the Bates number, the stamp style, and its placement on the printed document.

Print reports with embedded files

Reports and ReportBooks can now be printed with embedded files when printing to a PDF file. Reports with embedded links to attached files can now be shared with others who do not have access to CaseMap or the case.

CaseMap will only embed files that are in the Linked Files field in the object spreadsheets or the Authority and Extracts spreadsheet or Source(s) field for the Facts spreadsheet. During the print process, large documents or confidential documents can be removed.
Once the report is printed to PDF, spreadsheet records with linked documents or files will display a paperclip icon. Clicking the paperclip icon opens the linked document in a new window, in its native application.

- **Print search results from three different report options**

  The new Search Results pane contains three report options for printing search results: Search Report Books, Linked File Text Hits Report, and Review Linked File Hits. The latter two reports are offered as part of the DocManager add-in program.

- **Search spreadsheets, linked file content, and annotations**

  CaseMap now offers full-text search capabilities for spreadsheet records and linked files. Full-text searching also includes the ability to search annotation notes, restrict searches to select spreadsheets, and re-run recent searches. Full-text searching in CaseMap supports many of the common search operators used to produce precise search results.

  Search results display in a new Search Results navigation pane with a list of each spreadsheet that contains field text hits or linked files with search hits. The number of search hits returned for each spreadsheet also displays. Use the Narrow Results panel to view only those records that contain hits for spreadsheet fields, linked file text hits, or annotation note hits.

  Selecting a spreadsheet in the Search Results navigation pane displays the records with hits from that spreadsheet. Linked files that contain search hits display a file icon that opens the linked file. Annotated records with notes that contain search hits display an icon in an Annotation Note Hit column. Annotated notes can be previewed in a pop-up window when a mouse pointer is placed over the icon.

- **Review general user-interface changes**

  - The Total Litigator pane was removed from the Navigation pane. Data from LexisNexis online tools can still be sent to CaseMap.
  - The DocPreviewer pane was removed from the Navigation pane. DocPreviewer features still exist in CaseMap and can be accessed using menu options.
  - The Search option on the Records menu now displays "Filter". CaseMap no longer uses "filtering" and "searching" interchangeably.

---

**Resolved Issues**

**10.2 Build 266**

The following resolved issue has been added to CaseMap version 10.2 (Build 266) released September 5, 2014:

- **Backup and Restore was not available**
Backup and Restore is once again available in CaseMap. The functionality is the same as CaseMap 10.1 and earlier.

10.2 Build 265

The following resolved issue has been added to CaseMap version 10.2 (Build 265) released May 2, 2014:

- **Some of the links researching a person, organization, or issue did not work**
  
  CaseMap no longer includes the links that pointed to the decommissioned LexisNexis product Total Litigator.

10.1 Build 75

The following resolved issue has been added to CaseMap version 10.1 (Build 75) released August 9, 2013:

- **CaseMap would not index a case after updating the linked file for 40,000 or more records**
  
  Resolved an issue where updating the Linked File field for more than 40,000 records at once caused the indexer to crash. Rebuilding the index did not solve the problem. The indexer will now handle updating any number of records.

- **The E-mail to PDF Wizard did not convert some emails correctly on some systems**
  
  Resolved an issue where some of the PDF files showed parts of the email that were blacked out as if they had been redacted. This issue only occurred on systems where the current user registry settings for Internet Explorer (which is used in converting the emails) were overridden to use the machine-level settings.
10.1 Build 74

The following resolved issue has been added to CaseMap version 10.1 (Build 74) released June 14, 2013:

- **CaseMap may hang when closing a case during OCR processing**

  Resolved an issue where CaseMap would display a status dialog box and not close the case when attempting to close it while processing some documents for OCR. This issue only seemed to occur with some large PDF files.

10.1 Build 69

The following resolved issue has been added to CaseMap version 10.1 (Build 69) released March 28, 2013:

- **A delay occurred when using Acrobat 11 to open links created with the Acrobat plug-in**

  Resolved an issue where there was a delay of a few seconds when CaseMap tried to open a link created using the Acrobat plug-in using Adobe Acrobat 11 or Reader 11.

- **Links created with the Acrobat plug-in would not open in Adobe Reader 11 with Protected Mode enabled**

  Resolved an issue where links created with the Acrobat plug-in would not open in Adobe Reader 11 with Protected Mode enabled. The links opened as expected with Protected Mode disabled, as well as in prior versions of Adobe Reader.

10.1 Build 66

The following resolved issue has been added to CaseMap version 10.1 (Build 66) released July 13, 2012:

- **Images linked to Authorities or Extracts spreadsheets are not searchable without editing the records**

  Resolved an issue where CaseMap did not automatically index the text extracted from images linked to the Authorities or Extracts spreadsheets. CaseMap did not include these
images in the search results unless the records were edited after the OCR text had been extracted, causing them to be re-indexed. This issue only affects the Authorities and Extracts spreadsheets.

10.1 Build 63

The following resolved issues have been added to CaseMap version 10.1 (Build 63) released June 18, 2012:

- **CaseMap sometimes would not launch in a terminal services environment**
  Resolved an issue where CaseMap would sometimes not launch due to an error when running in a terminal services environment, such as Citrix.

- **CaseMap DocManager displayed [Deleted Object] for documents with no Full Name and Short Name**
  Resolved an issue where CaseMap DocManager incorrectly displayed the Full Name of the spreadsheet record for a linked file when viewing that file. If the spreadsheet record had neither a Full Name or Short Name field value, CaseMap DocManager displayed "[Deleted Object]". It now displays "**DELETED OR NO SHORT NAME**".

- **Send to CaseMap from a PDF downloaded from File and Serve was not working properly**
  Resolved an issue where Send to CaseMap from a PDF downloaded from File and Serve was not working properly, indicating "There was a problem reading the document."

10.0 Build 244

The following resolved issue has been added to CaseMap version 10.0 (Build 244) released May 2, 2012:

- **Send to Microsoft Word from CaseMap was not working properly with the CaseMap add-in for Word loaded**
  Resolved an issue where the Send to Microsoft Word feature in CaseMap was not working properly when a Word document was already open with the CaseMap add-in for Word loaded. The send operation fails with a warning message. Disabling the CaseMap add-in allowed sending data without a problem.
10.0 Build 241

The following resolved issues have been added to CaseMap version 10.0 (Build 241) released April 4, 2012:

- **CaseMap would not index a file open in Microsoft Word**
  
  Resolved an issue where CaseMap would not index a linked file that was open in Microsoft Word. CaseMap should index a file as long as it is not opened exclusively.

- **OCR was not working for some users due to a license error when processing linked files**
  
  Resolved an issue where the OCR was not working for some users due to a license error when processing linked images. Nuance provided version 18.1 of Licensing Manager, which corrected the issue.

10.0 Build 233

The following resolved issues have been added to CaseMap version 10.0 (Build 233) released February 24, 2012:

- **CaseMap would not create a new case when selecting a template from a prior version while in the New Case Wizard**
  
  Resolved an issue where CaseMap would not create a new case when selecting a template from a prior version while in the New Case Wizard. It displayed a message indicating there was a problem and would not continue. This problem exists in CaseMap version 9.

- **CaseMap would not OCR PDF files that contain any text**
  
  Resolved an issue where CaseMap would not OCR a PDF that contains text, even if most of the PDF is an image. This issue affects image PDF files that have been Bates stamped, since the stamps are usually added as text on top of the image. The resolution is a temporary workaround for users who only have image PDF files and is not enabled by default. Contact CaseMap Technical Support for assistance with this issue.
10.0 Build 229

The following reported issues have been resolved in CaseMap version 10.0 (Build 229) released February 16, 2012:

- **CaseMap could not embed .zip or .rar files in a PDF report**
  
  Resolved an issue where CaseMap could not embed a .zip or .rar file linked to a case in a PDF report. The PDF report was not generated. CaseMap now embeds the file correctly and generates the report.

- **CaseMap would not launch if the trial period had expired**
  
  Resolved an issue where CaseMap would not launch if the trial period has expired, and it could not be activated because the user was unable to access the activation wizard.

10.0 Build 227

The following reported issues have been resolved in CaseMap version 10.0 (Build 227) released February 13, 2012:

- **DocPreviewer converted emails to PDF with a black background**
  
  Resolved an issue where HTML and RTF emails converted to PDF from DocPreviewer's Email to PDF Wizard resulted in a black background for the email's body text on computers that had Windows version 7 installed and the Internet Explorer version was upgraded to version 9. This issue made it impossible to read the email's body text. A hot fix for this issue is also available for CaseMap versions 8 and 9. Contact CaseMap Technical Support to obtain the hot fix.

- **Send to TimeMap feature did not recognize a custom date-only field**
  
  Resolved an issue where records from a spreadsheet that displayed a custom date-only field were sent to TimeMap and CaseMap did not send the date entered in the date-only field. The date that displayed in TimeMap was the current date. This issue only occurred with custom date-only fields. Date and time fields did not have this problem.

- **CaseMap incorrectly adjusted the GMT time zone for Daylight Saving Time**
  
  Resolved an issue where CaseMap adjusted for Daylight Saving Time in Fact records with dates entered that specified the Greenwich Mean Time (GMT) time zone. GMT does not observe Daylight Saving Time.

- **CaseMap crashed when the number of active monitors was changed on a multi-monitor**
Resolved an issue where an unhandled exception error occurred and caused CaseMap to shut down when the number of active monitors was changed on a multi-monitor system and caused a change in some of the screen tips in CaseMap. This issue occurred when a projector was unplugged while CaseMap was running and a mouse cursor was placed over a spreadsheet field header to display a screen tip.

Resolved an issue where a few features in CaseMap that require an exclusive lock did not release the exclusive lock when the feature was finished being used. CaseMap features that require an exclusive lock include: Create Replica Wizard, Auto Number Records (case tool), Bulk Field Copy (case tool), and Bulk Field Update (case tool).

Current Issues

10.1 Build 67

The following items are current issues in CaseMap version 10.1 (Build 67) released December, 2012:

Send E-mail to CaseMap menu item does not appear when right-clicking on an e-mail in Outlook 2013

The Send E-mail to CaseMap menu item does not appear when right-clicking on an e-mail in Microsoft® Outlook 2013. The corresponding button is still available in the CaseMap tab on the ribbon at the top of the screen.

10.0 Build 227

The following items are current issues in CaseMap version 10.0 (Build 227) released February 13, 2012:

CaseMap DocManager Linked File Text Hits report includes a temporary file name in the footer of each page when printed

CaseMap uses Internet Explorer to display the report, and it includes the temporary file name for the HTML file by default. The workaround is to change the footer format text in the Internet Explorer Page Setup dialog for the purpose of printing this report.
CaseMap Release Notes

- **CaseMap DocManager does not support opening attachments in Outlook MSG or PDF files**

  When viewing an Outlook email (MSG) or PDF file in CaseMap DocManager, it is not possible to view the attachments contained in those files. Use the Open Native feature to view the email in Outlook or the PDF in Acrobat to access the attachments.

- **Searching for a word followed by an Object Short Name does not return any results when the search text is enclosed in quotes**

  CaseMap allows entering a search with a word followed by an Object Short Name where the search text is enclosed in quotes, but when running the search, it does not return any hits. For example, searching for "including HawkinsP" (with the quotes) in the Hawkins example case does not return any results. Change the search text not to include the quotes, e.g. including HawkinsP.

- **When searching for a number, some spreadsheet hits are included because one or more the date fields include that number**

  CaseMap indexes dates as numbers also. If a date field, such as the Creation Time Stamp field, includes the number being searched, then that spreadsheet record will be returned as a hit. For example, the search =12 will return records with a Creation Time Stamp of 12/31/2011.

- **CaseMap DocManager may not highlight all of the hits in a document**

  CaseMap DocManager may not highlight all of the hits in document when viewing documents from the search results. The indexed text may have slightly different word breaks than displayed in the CaseMap DocManager viewer. CaseMap may also find search hits in the document properties, which are not visible in CaseMap DocManager.

- **CaseMap does not search the original document properties of an image**

  CaseMap does not retain the properties, or metadata, of an image that must be processed for OCR for the purpose of full-text searching. For example, CaseMap will not find search hits in the properties of a TIFF image linked to the case. Use the Open Native feature to view the original properties for an image.

- **Existing annotations are not removed when changing the Linked File value for a spreadsheet record**

  CaseMap does not delete the annotations that are associated with a spreadsheet record when changing the value in the Linked File field. This behavior avoids losing annotations on a document when changing the path to the linked file, rather than linking a different file to the record. There is not currently a mechanism in place to determine that it is the same file in a different location. The workaround is to clear the Linked File value and save the record. Then link to the new file.

- **PDF files with a password protection encryption level higher than 40-bit (RC4) are not indexed**

  Some PDF files may be reported as encrypted during indexing, even though no password is needed to open the file. This can occur because encryption is sometimes used in PDF files to enforce restrictions on printing or extracting text from a PDF file.

  PDF files can have two kinds of passwords:

  1. A password that prevents any access to the file unless the user enters a password
before opening it in Adobe Reader. CaseMap cannot index files with this type of encryption at all.

2. A password that prevents certain operations (printing, editing, etc.) only. This type of PDF file can be opened in Adobe Reader with no need to enter a password, but other actions may not be allow for file. CaseMap can index this type of PDF file only if the encryption level is 40-bit (RC4). If higher-level encryption is used, then CaseMap cannot access the text in the PDF file.

To tell what kind of encryption is used in a PDF file, open the PDF file in Adobe Reader and click File > Document Properties, and click the Security tab.

- **CaseMap DocManager may not display all of the pages in a PowerPoint presentation in 2007 or later format**

  CaseMap DocManager only displays the first couple of pages for some PowerPoint 2007 format files. This problem does not occur with all PowerPoint presentations. If it does occur, use the Open Native feature to view the presentation in PowerPoint.

- **Highlighting the search hits in some large (700 pages or more) files may take longer than a minute**

  Hit highlighting large documents in CaseMap DocManager takes a long time. This issue seems to occur with any large PDF. The larger the file, the longer it takes to do the hit highlighting. By default, CaseMap DocManager does not automatically hit highlight any document with more than 30 pages, but there may be a noticeable delay when clicking the information bar at the top of the document to display the highlighted hits.

- **CaseMap DocManager switches to the Fit Page view when opening a link to an annotation from the search results**

  CaseMap DocManager zooms out to show the entire page of the document containing the linked annotation to ensure that the annotation is visible instead of scrolling the document without changing the zoom level.

- **CaseMap DocManager may not display text correctly in some PDF files**

  CaseMap DocManager may skew the text in some PDF files contains text on top of an image. This problem does not occur with most PDF files. If it does occur, use the Open Native feature to view the file in Adobe Acrobat or another PDF viewer.

- **CaseMap DocManager will not display some CSV files**

  CaseMap DocManager will not display Comma Separated Values (CSV) files containing some special characters. These characters are shown in the Insert Symbol dialog with keystrokes of Alt+0160 and higher. These are special symbols, such as copyright and registered trademark, and foreign language characters that are not likely to be found in most CSV files. If this problem occurs, use the Open Native feature to view the file in another program, or change the file extension of the file from .csv to .txt.

- **CaseMap DocManager is very slow to open files when Lucion File Center is configured for use with CaseMap**

  CaseMap DocManager is not currently compatible with Lucion File Center, which is a third-party product intended to replace Windows Explorer for navigating files on a computer. When using this product, it takes much longer to open even small documents in CaseMap.
DocManager.

- **CaseMap does not OCR PDF files that contain any text**

  CaseMap will not OCR a PDF that contains text, even if most of the PDF is an image. This issue affects image PDF files that have been Bates stamped, since the stamps are usually added as text on top of the image.

- **CaseMap cannot embed .zip or .rar files in a PDF report**

  CaseMap cannot embed a .zip or .rar file linked to a case in a PDF report. The PDF report is not generated.

- **CaseMap will not launch if the trial period has expired**

  CaseMap will not launch if the trial period has expired, and it cannot be activated because the user is unable to access the activation wizard. Contact CaseMap Technical support for assistance with this issue.

- **CaseMap DocManager does not hit highlight proximity phrases correctly**

  CaseMap DocManager highlights occurrences of individual words in a phrase or proximity search, in addition to the full phrase. For example, when searching for the phrase hawkins left, all occurrences of hawkins, left, and hawkins left are highlighted, even though they are not returned as hits in the search.

- **CaseMap DocManager displays [Deleted Object] for documents with no Full Name and Short Name**

  CaseMap DocManager displays the Full Name of the spreadsheet record for a linked file when viewing that file. If the spreadsheet record has neither a Full Name or Short Name field value, CaseMap DocManager incorrectly displays "[Deleted Object]". Specify a Full Name for the spreadsheet record to display a meaningful name when viewing the linked file.

- **CaseMap cannot delete a spreadsheet with several thousand records on it from an Access case**

  CaseMap shuts down with an error when trying to delete an Object spreadsheet with several thousand records on it. To avoid this problem, delete all of the records from the spreadsheet first by clicking Tools > Case Tools > Delete All Records in View. Then try deleting the spreadsheet.